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Specifying Criteria For Your Queries 
 
The Radiocommunication Bureau’s Space Data and Publication Circular Query and Extract 
System, known as SpaceQry, is a software package that supplies both the BR’s internal and 
external users with a tool that accesses and queries all BR formatted Space Databases: these 
include the Space International Frequency Information Circular (IFIC) databases, Network Station 
List (NSL) databases, Space Capture databases, and Space Radiocommunication Station (SRS) 
databases. 
 
The purpose of this document is give you, as a SpaceQry user, a clearer understanding of how to 
use the criteria-specifying dialogue which is invoked each time a BR Space Database is opened. 
 
A hyperlinked table of contents for this document, which will direct you to the subject of your 
interest or question, is supplied on the left; however, it is suggested that you take the time to read 
the document in its entirety, even if you are an experienced SpaceQry user.  
 
 
This document was last updated on 28 March 2012 to reflect SpaceQry software changes up to 
and including the Version 6.4 release.   To view or download updated versions of this document, 
please check the documentation page of the SpaceQry website: 
 

http://www.itu.int/en/ITU-R/software/Pages/spaceqry.aspx
 
or, to view the latest, up-to-date html-version of this document, please see the SpaceQry online 
query guide of the SpaceQry website:  
 

http://www.itu.int/en/ITU-R/software/Documents/spaceqry/SQryGuide.pdf
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The SpaceQry Criteria Dialogue 
 
Beginning in October 1999, the Radiocommunication Bureau began its task of moving all data and 
processing from its legacy systems on the Siemens mainframe computers into a client server 
environment using Windows NT, Unix, and Ingres.  As a result, SpaceQry is now the querying tool 
used at the BR against both its Ingres and MS-Access databases.  The Bureau's querying 
requirements are often different from those of its member administrations and organizations, and 
as a result, SpaceQry is evolving well beyond its original intended use as a "Weekly Circular 
viewer." 
 
Due to ever-increasing requests for additional querying criteria and the inclusion of the Plans, 
Advanced Publications, and Due Diligence data into the SRS database, a single criteria screen, or 
window, is no longer sufficient to display and capture the querying information.  For this reason the 
SpaceQry Criteria window is now presented as a series of tab-windows (similar to what you will 
see in many Microsoft products as option or preference dialogues).  The criteria are organized 
logically onto the appropriate tab window, each of which can be accessed by clicking on its 
associated tab. 
 

 
 
An explanation of menu items, utilities, and help aids, as well as each tab and the criteria fields 
found on them is discussed at length in the sections that follow.   
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The Criteria Window Menu 
 

The File Menu 
 
The following three actions are available from the File submenu of the Criteria window.  The 
actions are described as follows: 
 

• Close Criteria Window this action and the corresponding button labeled Close, will 
close the criteria window, close any associated query detail windows, and close the 
associated BR Space database (along with the ODBC connection).  You may also invoke 
this action using a Ctrl+F4 keystroke. 

• Print Criteria Window this action will print a bitmap image of the Criteria Window to 
your default printer.  The image is sent directly to the printer without invoking a printer 
dialogue.  You may also invoke this action using a  Ctrl+P keystroke. 

• Exit SpaceQry   this action will perform a shutdown of the SpaceQry software.  It 
will first Close the Criteria Window as describe above, and the close any other outstanding 
windows.  If you have the Query before exit  option selected from the Preferences dialogue, 
then you will be asked to confirm the shutdown.  You may also invoke this action using an  
Alt+F4 keystroke. 

 
 

The Help Menu 
 
The following actions are available from the Help submenu of the Criteria window.  The actions are 
described as follows: 
 

• Specifying criteria for… selecting this menu item will produce a submenu with a 
complete list of criterion fields on the various tab windows of the Criteria Window. Selecting 
one of these sub-items will produce a Quick Help pop-up window for the associated 
criterion field.  A Quick Help pop-up window is available for each criterion field present in 
one of the Criteria window’s tab windows.  Selecting one of these sub_items is equivalent 

to clicking on the    button associated with the criterion field. 

• Tips and Tricks  selecting this option will invoke the SpaceQry Tips and Tricks 
dialogue for SRS Queries. 

• Querying Guide  selecting this option will display this document in its PDF format 
using Adobe Acrobat™.  You may also invoke this action using an  Alt+G keystroke. 

• About SpaceQry  selecting this option will produce the SpaceQry splash screen, 
which gives the current SpaceQry version number, copyright information, and a contact 
address, telephone, and fax number. 
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The Actions Menu 
 
In general, each item in the Actions submenu directly corresponds to one of the Action  buttons 
located at the bottom of the Criteria window.  The actions are described as follows: 
 

• Execute Query  this action and the corresponding button labeled Query, will actually 
launch the query using the criteria which you currently have specified, relative to the type of 
query you are executing.  You may also invoke this action using an Alt+Q keystroke. 

• Make NSL   this action and the corresponding button labeled Make NSL, will 
attempt to create a Network Station List (or export) database based on the results of a 
Network–level query which has been based on the criteria which you have currently 
specified.  You may also invoke this action using an Alt+N keystroke. 

• Clear Criteria/SQL this action and the corresponding button labeled Clear, will allow you 
to either clear the criteria fields on the current (visible) tab window, or to clear the criteria 
fields on all tab windows (clear query).  If the current tab is the Adhoc Query tab, resulting 
from an Edit SQL  action (see below), then a Clear request will return you to a non-edit SQL 
state and allow you to continue to specify criteria.  If the current tab is the Adhoc Query tab, 
resulting from requesting a query type of Adhoc, then the Clear request will empty the SQL 
edit window.  You may also invoke these actions using an Alt+C keystroke. 

• View SQL  this action and the corresponding button labeled View SQL, will 
display a pop-up window presenting the SQL statement that is generated by the criteria 
which is currently specified.  You may also invoke this actions using an Alt+V keystroke. 

• Edit SQL  this action and the corresponding button labeled Edit SQL, will generate an 
SQL statement based on the currently specified criteria, and insert it into the SQL 
Statement area on the Adhoc Query tab, allowing you to edit the statement as desired.  
You may also invoke this action using an Alt+E keystroke. 

• Show example  this action and the corresponding button labeled Example, will invoke 
an audio/visual example of specifying a query of the type selected.  At the time of this 
writing, the Standard Query is the only example which has been implemented.  You may 
also invoke this action using an Alt+X keystroke. 

• Show Criteria Summary  this action will invoke a pop-up window which displays a 
summary of all criteria specified up to that point.  This is sometimes useful when you would 
like a last-minute check on the criteria before executing the query.  You may also invoke 
this action using a Ctrl+S keystroke. 

• Save this Query this action and the corresponding button labeled Save, will save all 
criteria specifications to a database record and store it into the SRSQueries.mdb database 
to allow you to recall it at another time.  You will be asked to supply a name and a 
description for the saved query.  Once the saving procedure is completed, you will be 
returned to your state prior to requesting the action.  You may also invoke this action using 
an Alt+S keystroke. 

• Recall a saved query this action and the corresponding button labeled Recall, will 
make the Stored Queries tab the current tab, and allow you to select a stored query to 
recall or re-instate.  This action is equivalent to clicking on the Stored Queries tab.  You 
may also invoke this action using an Alt+R keystroke. 

• Import Queries  this action will allow you to import the saved queries from another 
SpaceQry Queries database.  This action is only available from the Stored Queries tab.   

• Edit Query info this action and the corresponding button labeled Edit Info, will allow 
you to edit the name and/or description of a stored query.  This action is only available from 
the Stored Queries tab.  You may also invoke this action using an Alt+I keystroke. 

• Select Query  this action and the corresponding button labeled Select, will re-instate 
the currently selected query from the stored query list.  This action is only available from 
the Stored Queries tab.  You may also invoke this action using an Alt+L keystroke. 
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• Delete Query  this action and the corresponding button labeled Delete, will allow 
you to delete the currently selected stored query.  This action is only available from the 
Stored Queries tab.  You may also invoke this action using an Alt+D keystroke. 

The Options Menu 
 

Group Finder Utility 
 
To aid in the sometimes-tedious task of cross-referencing Group IDs with Network IDs, the 
standard query criteria screen now has a "Group Finder" dialogue (from the Options menu item) 

which allows you to enter a Group ID and 
retrieve the associated Network ID and 
beam information.  This can then be 
copied into the BR Network ID criterion 
field.  Later, when the query has been 
issued, and the Network Detail window is 
displayed, you will be shown a reminder 
CueCard  containing the Network ID, 
Beam ID, and emission-reception indicator 
of the Group for which you are looking. 
 

 
As an example, let’s assume you have obtained the group ID 97977410  from another query, or 
perhaps the printout from a technical examination program.  If you would like to view the Network–
level information corresponding to this frequency group but do not know the corresponding 
Network ID, you can invoke the Group Finder Utility by typing  Ctrl+G  or by selecting the 
associated menu item as shown in the illustration above.  As shown below on the left, once the 
Group Location Finder window appears, type the value  97977410  into the edit field labeled Group 
ID and then click on the  button. 
 

   
 
At this point the utility locates the corresponding network information and displays the Network ID, 
Emission / Reception flag and the Beam Name as shown above on the right.  To insert the 
Network ID value into the BR Network ID criterion field on the General Criteria tab, click on the 

 button. 
 
If you then execute a query using this inserted 
network ID value, once the Network Detail window 
has been displayed, you will also be shown the 
following Cuecard which will help direct you to the 
frequency group in question: 
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Identification Numbers Option 
 
Each network or notice can be uniquely identified in one of two ways: either by the BR assigned 
Notice ID or by the combination of the administration/organization codes and the administration 
supplied Administration Reference ID.  It should be noted here, however, that to date, very few 
administrations actually notify their reference Ids, and obviously, if they are not present in the 
source database for a query, then this present discussion is moot.  
 
SpaceQry has only one field for an Identification criterion, and the default for this Identification 
criterion field is to look for BR ID numbers.  To search on Administration Reference IDs, you must 
first select the Use Admin IDs option from the Options : Identification numbers menu item at the 

top of the SpaceQry window, as 
shown on the right.  After selecting 
this option, the label for the 
Idenification criterion field (located on 
the General Criteria  tab) will change 
from BR Network ID  to 
Administration’s Ref ID, and 
thereafter, any values entered into 

that field will be interpreted as possible values for the administration’s reference ID.   
 
For a more detailed discussion, please see the subsection on this same subject located in the 
General Criteria  tab section of this document. 
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Criteria Window Action Buttons 
 
The following illustration shows each of the Action Buttons for the SpaceQry Criteria Window, and 
their meaning and association to the Criteria Menu items discussed in the previous sections: 
 

 
 

For those users who prefer their buttons with text, these icons can be suppressed by unchecking the Use 
icons on buttons box on the Defaults tab of the Preferences dialogue: 
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The Criterion Value List Windows 
 
While perusing the various tab windows of the SpaceQry Criteria dialogue, you will find 

immediately to the right of certain criteria fields, a small Show … values button .  The presence 
of this button implies that, upon request (i.e., clicking on the button), SpaceQry will produce for that 
criterion field a sorted list of unique values which are currently in the database against which you 
are querying; in other words, each list is not an absolute list, it is an intelligent list which includes 
only the values which are actually present in the targeted database.  Examples of requesting 
existing values for satellite names or earth station names are as follows: 
 

              
 
 
If a list is long, as in the case for satellite names, you may quickly zoom in on values by typing the 
first few characters of the desired value into the edit field located at the top of the List window.  In 
the example shown above on the left, Intelsat satellites can be easily located in the list by typing in 
the value   int  .   
 
To select a value for insertion into the criterion field on the associated tab, you may either double-

click on the value in the list, or click on the value in the list and then click on the select  
button.  In either case the value will be inserted into the appropriate criterion field on the 

associated tab.  To close a Criterion List window, click on the close  button. 
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The Criterion Information (Quick Help) Windows 
 
As with the Criterion Value List windows mentioned above, certain other criteria fields located on 

the tab windows may have a small    Info on … button   located immediately to their right.   
 

In these cases, clicking on the    button will produce a Quick Help window which tells you what 
the field is and how to enter a value for it; in most cases an example is shown as well.  As an 
example, clicking on the Obital Position Info button yields: 
 

  
 
These Criterion Information windows are also accessible from two other sources.  First, from the 
Help : Specifying criteria for… submenu of the SpaceQry menu as shown below: 
 

 
 
 
and they are also available from the context menu which is produced by right-clicking the pointing 
device over an area of the Criteria  tab window in question: 
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The Query Type Tab 
 
Normally the query “type” is preset due to the menu or toolbar selection which invoked the criteria 
dialogue (e.g., clicking on the DVD-ROM toolbar icon will invoke a standard query session).  
However, the query type may be changed at any time by selecting a different query type on the 
Query Type tab.  
 

 
 

Standard Queries 
 
Standard queries are used for perusing the entire structure of the data which the BR publishes.  
Querying is done at the topmost, network level to identify a list of satellites and/or earth stations.  
Once the list of notices is obtained, you may walk through, or navigate all of the data specific to 
each notice in the list.  Typically, you would use this query to review the bi-weekly IFIC 
publications, or to identify a set of networks from the SRS to review or export. 
  

Frequency Overlap Queries 
 
Frequency Overlap queries identify which networks contain frequencies that overlap a given 
frequency band or group of bands.  Querying can be done at the network level, frequency group 
level, or individual frequency level.  Typically, you would use this query to help identify potential 
needs for coordination. 
 

Adhoc SQL Queries 
 
The Adhoc SQL queries option allows you to design any SQL query against the currently selected 
BR Space database.  The querying can be done on any level and against any table or combination 
of tables.  The result of the query will be a speadsheet-like list, which you may export or print. 
 

Quick Queries 
 
Quick queries are a number of pre-defined queries (using minimal criteria) which identify frequently 
requested information about a specific network. 
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The General Criteria Tab 
 
The general criteria tab allows you to select networks and stations based on certain 
“administrative” criteria, including publication circular information, notifying administration 
information, and the Radio Regulations under which the notification occurred.   This tab is also 
where you specify the desired collating order of the networks and stations resulting from a 
standard query.   Each of these items is discussed separately below. 
 
  

 
 
 

Notification Reason Criterion 
 
Notification Reason or Category is an internal BR code which indicates whether the notice was 
submitted under one of the following Radio Regulations: 
 

-   RR1488   [ Notification ],   
-   RR1060   [ Coordination ],  
-   RR1042   [ Advanced Publication ],  
-   RR49    [ Due Diligence ],  
-   RR1107   [ Earth Station Coordination ],  
-   Appendix 30/30A  [ BSS Plan ], 

or -   Appendix 30B   [ FSS Plan ]. 
 

You may specify one or more of these as criteria by checking the desired box(es).  As an example, 
to see all satellite networks which were notified under Appendices 30/30A or 30B, you should 
check both the   BSS Plan  and    FSS Plan   boxes. 
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Administration Code Criterion 
 
Administration code is a 1 to 3 digit code which represents the country which administers the 
Space Network or Earth Station.  This criterion is a list of administration codes which you wish to 
include or exclude from the search.  You should enter into this field one or more valid 
administration codes, comma separated.  To denote exclusion, you should prefix the 
administration code with a hash character (#).  
 
As an example, to include all French and German networks, enter:   F, D   
 

You may alternatively click on the Show Administration Codes button   located immediately to 
the right of the administration code field.  SpaceQry will then produce a list of all administration 
codes which are in the currently selected database.   You may then select one or more codes from 
this list to include in your query.  For more information on how to do this, please refer to the section 
on Criterion Value Lists  at the beginning of this chapter. 
 
 

Network Organization  Code Criterion 
 
The Network Organizations criterion is a list of Organization codes which you wish to include or 
exclude from the search.  You should enter into this field one or more valid organization codes, 
comma separated.  To denote exclusion, you should prefix the organization code with a hash 
character (#).  
 
As an example, to exclude all Intelsat networks, enter:   # IT  
 

You may alternatively click on the Show Organization Codes button   located immediately to the 
right of the organization code field.  SpaceQry will then produce a list of all organization codes 
which are in the currently selected database.   You may then select one or more codes from this 
list to include in your query.  For more information on how to do this, please refer to the section on 
Criterion Value Lists  at the beginning of this chapter. 
 
 

BR Network ID  Criterion 
 
The BR Identification is the network identification number which is generated by the BR and 
assigned to each incoming notification.  You should enter into this field one or more network ID 
values separated by commas,  or a range of ID values separated by the double symbol “..” or the 
word “to”.  
 
As an example, to select all networks received by the BR in 1998, enter:   98000000 to 98999999  
 
 

Administration’s Reference  ID  Criterion 
 
The Administration Reference Identification is the identification number or code which is supplied 
by the notifying administration for each incoming notification.  You should enter into this field one 
or more reference ID values separated by commas.  To denote wildcard selections, you should 
suffix the supplied value with an asterisk(*) or percent(%).  
 
As an example, to select all networks with administration references beginning with RU, enter:  ru* 
 

You may alternatively click on the Show AdminID Values button    located immediately to the 
right of the reference ID field.  SpaceQry will then produce a list of all reference IDs which are in 
the currently selected database.   You may then select one or more values from this list to include 
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in your query.  For more information on how to do this, please refer to the section on Criterion 
Value Lists  at the beginning of this chapter. 
 
NB.,  The default for the Identification criterion field is to look for BR ID numbers.  To search on 
Administration Reference IDs, you must first select the Use Admin IDs option from the Options : 
Identification numbers menu item at the top of the SpaceQry window.  If desired, you may change 
this default to automatically query using the Administration Reference ID, by selecting the 
appropriate option in the SpaceQry Preferences dialogue which is discussed elsewhere in this 
manual. 
 

BR Status Criterion 
 
The BR Status is a two digit number which represents the current stage of the processing of the 
network notification within the Bureau.  Typically, the semi-annual publication of the SRS database 
on DVD-ROM only contains networks which are in status 50, or the Update Status; as a result, this 
criterion may not be useful to users outside the ITU.  However, to use the criterion, you should 
enter into this field one or more valid BR status values, comma separated.  To denote exclusion, 
you should prefix the BR status value with a hash character (#).  
 
As an example, to select all 'updated' notices, enter:   50  
 

You may alternatively click on the Show BR Status Values button   located immediately to the 
right of the BR status field.  SpaceQry will then produce a list of all BR status values (and their 
meanings) which are in the currently selected database.  NB., this is particularly important for BR 
users because, if an expected status value does not appear in the list, it means that there are 
currently no notices in that status.  You may then select one or more values from this list to include 
in your query.  For more information on how to do this, please refer to the section on Criterion 
Value Lists  at the beginning of this chapter. 
 
 

Publication Number  Criterion 
 
The Publication Circular number is a criterion which is normally used to locate all networks which 
were published in a specific Weekly Circular (through December 1999) or International Frequency 
Information Circular, or IFIC, (from January 2000).  You should enter into this field one or more 4-
digit values, separated by commas.  To specify a range of circular numbers, enter two values 
separated by the double symbol ".."  or  the word  "to"  . You may also specify multiple (single) 
values and ranges separated by commas.  
 
As an example, to select all notices published in Space Weekly Circulars before number 2400,  
enter:         0 to 2399     
 

You may alternatively click on the Show WIC/IFIC Numbers button   located immediately to the 
right of the Publication Number field.  SpaceQry will then produce a list of all WIC and IFIC 
publication numbers which are in the currently selected database.   You may then select one or 
more values from this list to include in your query.  For more information on how to do this, please 
refer to the section on Criterion Value Lists  at the beginning of this chapter. 
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Publication Part  Criterion 
 
The Publication Part number is a criterion which is normally used when querying a WIC or IFIC 
publication.  The possible code values for this field are: 
 

• 1, a, 1a  for publication in part 1; 
• 2   for publication in part 2; 
• 3   for publication in part 3; 
• s,  ss  for publication in special sections. 

 
You should enter into this field one or more of these values, separated by commas. 
 
As an example, to select all networks from a WIC or IFIC database which were updated into the 
BR master register, enter:  2  
 
 

Standard Query Sorting Order 
 
SpaceQry automatically specifies the eight most frequently requested sorting orders for Standard 
Queries.  Each of these are described below; however, it should be noted here that any other 
sorting order can be specified by editing the order by clause of the SQL statement generated by 
your criteria.  For more information on how to edit the SQL statement, please see the Adhoc Query 
Tab section  in this chapter.  The supplied sorting orders are: 
 

• Administration : sorted by administration code, satellite name & notification reason; 
• Orbital Position : sorted by nominal longitude, administration code and organization; 
• Adm Identification : sorted by administration code & administration reference ID; 
• BR Identification  : sorted by BR identification number; 
• Notification reason : sorted by notification reason, administration code & satellite name; 
• Publication Number : sorted by WIC/IFIC number and part, administration code and 

satellite name 
• Plan Name  : sorted by plan name, administration code, and satellite name; 
• BR Status  : sorted by BR status, date of receipt, and administration code. 

 
The default sorting order is by Administration; to select a different sorting order, simply click on the 
associated radio button. 
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As of SpaceQry version 2.2, a hook has been added by which you may create (and include on the 
criteria window) your own special sorting order for standard queries.   To do this you must supply 
the necessary information in the [Queries]  section of the SpaceQry.ini  file.  This section must 
contain the following three parameter items:   
 

• SpecialSortCaption : the radiobutton label; 
• SpecialSortDescr : the status-bar description statement; 
• SpecialSortFields : the list of (database) sorting fields, comma separated. 

 
As an example, assume you would like to have a sorting order based on the BR Date-of-receipt 
value, followed by administration and organization codes.  You would therefore need to add (or 
modify) the following 3 lines in the [Queries] section: 
 

[Queries] 
   ... 
SpecialSortCaption=Date of receipt 
SpecialSortDescr=date of receipt, administration, and organization 
SpecialSortFields=d_rcv,adm,ntwk_org 

 
The General Criteria Tab would thereafter show a Date of receipt option in the sorting order area. 
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The Station Criteria Tab 
 
 As the name implies, the Station Criteria Tab lists all querying criteria which specifically 
relate to the various station types.  The tab is divided into two areas: the first relating to satellites 
(space stations) and the second relating to earth and radioastronomy stations (terrestrial-based 
stations).  Each station criterion is discussed separately below. 
 

 
 
 

Satellite Type Criterion 
 
Satellite Type is a criterion which specifies whether you wish to select geostationary satellites 
and/or non-geostationary satellites.  You may select either one or both of these options by 
checking the desired box(es).  It should be noted here that this criterion works in conjunction with 
the Station Type criterion discussed below (since they both refer to the same database field); 
therefore,  selecting either of these criteria will automatically exclude both earth and 
radioastronomy stations unless they are specifically selected. 
 
As an example, to select only non-geostationary satellite networks, check only the  non-
geostationary   box. 
 
 

Satellite Name Criterion 
 
The Satellite Name criterion is a list of satellite names which you wish to include or exclude from 
the search.   You should enter into this field one or more valid satellite names separated by 
commas.   For wildcard selections, you should suffix the value with an asterisk(*) or percent(%). 
 
As an example, to include all Eutelsat satellites, enter the value:    eutelsat*  
 

You may alternatively click on the Show Satellite Names button    located immediately to the 
right of the satellite name field.  SpaceQry will then produce a list of all satellite names which are in 
the currently selected database.   You may then select one or more names from this list to include 

16 



SpaceQry:  Specifying Criteria For Your Queries 

in your query.  For more information on how to do this, please refer to the section on Criterion 
Value Lists  at the beginning of this chapter. 
 
 

Satellite Orbital Position Criterion 
 
An Orbital Position or Satellite Longitude range is a pair of (decimal) longitude values indicating a 
(nominal) longitudinal band in which you wish to select satellites.  You should enter into this field 
one or two values between -180 and 180 degrees, separated by the double symbol ".."  or  the 
word  "to"  .   A single value will require an exact match on the orbital position of the satellites, 
while a range will include any satellite whose orbital position falls inside the range.  You may also 
specify multiple (single) values and ranges separated by commas.  
 
As an example, to select all satellites whose orbital position is exactly 15 degrees West or 
somewhere between 10 degrees West and 30 degrees East,  enter:        -15, -10.0 to 30.0  
 
 

Station Type Criterion 
 
Station Type is a criterion which indicates whether you wish to select specific earth stations, typical 
earth stations, or radioastronomy stations. You may select one or more of these by checking the 
desired box(es).  It should be noted here that this criterion works in conjunction with the Satellite 
Type criterion mentioned previously (since they both refer to the same database field); therefore,  
selecting any one of these three criteria will automatically exclude both geo and non-geo satellites 
unless they are specifically selected.  
 
As an example, to select only radioastronomy stations, check only the   Radioastronomy  box. 
 
 

Station Name Criterion 
 
The Station Name criterion is a list of Station names which you wish to include or exclude from the 
search.   You should enter into this field one or more valid Station names separated by commas.   
For wildcard selections, you should suffix the value with an asterisk(*) or percent(%). 
 
As an example, to include all earth station names beginning with Halifax , enter the value:   halifax* 
 

You may alternatively click on the Show Station Names button    located immediately to the 
right of the station name field.  SpaceQry will then produce a list of all station names which are in 
the currently selected database.   You may then select one or more names from this list to include 
in your query.  For more information on how to do this, please refer to the section on Criterion 
Value Lists  at the beginning of this chapter. 
 
 

Station Country Criterion 
 
The Country criterion is a list of Country codes which you wish to include or exclude from the 
search.  In this field you may enter one or more valid country codes, comma separated.  To denote 
exclusion, you should prefix the country code with a hash character (#).  
 
As examples: 

• to include all earth stations in Canada and the USA, enter:    can,usa  
• to exclude all Mexican earth stations, enter:    #mex  
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You may alternatively click on the Show Country Codes button    located immediately to the 
right of the country field.  SpaceQry will then produce a list of all country codes which are in the 
currently selected database.   You may then select one or more codes from this list to include in 
your query.  For more information on how to do this, please refer to the section on Criterion Value 
Lists  at the beginning of this chapter. 
 
 

Station Latitude/ Longitude Criteria 
 
The earth station latitude and longitude criteria allow you to identify earth or radioastronomy 
stations by their geographical location.  Any of the following may be done: 
 

• for a specific (and exact) geographical coordinate,  
• for either latitudinal or longitudinal bands, 
• for a geographical area defined by both latitudinal and longitudinal bands. 

 
The Earth Station Latitude range is a set of (decimal) latitude values indicating a latitudinal band in 
which you wish to select earth or radioastronomy stations  You may enter into this field one or two 
values between -90 and 90 degrees, separated by the double symbol ".."  or  the word  "to".  A 
single value will require an exact match on the latitude of the station, while a range will include any 
station whose latitude falls inside the range.  You may also specify multiple (single) values and 
ranges separated by commas. 
    
As an example, to select all earth stations geographically located in a band between 37 and 60 
degrees North,  enter:       37.0 to 60.0  
 
The Earth Station Longitude range is a set of (decimal) longitude values indicating a longitudinal 
band in which you wish to select earth or radioastronomy stations  You may enter into this field one 
or two values between -180 and 180 degrees, separated by the double symbol ".."  or  the word  
"to".  A single value will require an exact match on the longitude of the station, while a range will 
include any station whose longitude falls inside the range.  You may also specify multiple (single) 
values and ranges separated by commas. 
    
As an example, to select all earth stations geographically located in a band between 10 degrees 
West and 30 degrees East,  enter:       -10.0 to 30.0  
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The Frequency Criteria Tab 
 
The frequency criteria tab allows you to select networks and stations based on whether their 
notified frequencies fall into specified ranges or bands. The criteria specified on this tab can be 
used in both Standard and Overlap queries, as well as certain Quick queries.   You may also 
(optionally) specify a network ID and SpaceQry will automatically generate a list of unique 
frequency bands which are used by that network - you may then use all or some of those 
frequencies to query against the SRS database.  Each of these items is discussed separately 
below. 
 

 
 

Include Frequency Bands Area 
 
This text-editing field in the middle-left of the tab is the area into which you type the desired 
frequency bands to be used in the query.  A Frequency band range is a set of (decimal) frequency 
values (expressed in MHz) indicating a frequency band in which you wish to select networks. You 
should enter into this edit field two numeric values, separated by the double symbol ".."  or  the 
word  "to", and then click on the  button to add the band to your list (which is located directly 
below the edit field). 
 
As in the example shown above, to select all networks with frequencies operating within a 14.1 
GHz to 14.2455 GHz band, you should enter: 14100 .. 14245.5 and click on the  button. 
 
 

Satellite Network / Earth Station  Area 
 
This text-editing field located in the upper-left corner of the tab is the area into which you may 
optionally type a target network ID whose frequencies are to be used in the query.  As described in 
the section on the General Criteria Tab, this is the identification number assigned to the network by 
the BR upon receipt of the notification. After entering the desired network ID into this field you 
should hit the enter-key, tab-key or, using the pointing device, click in another area of the window.  
SpaceQry will retrieve the network and produce a list of all distinct and non-overlapping frequency 
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bands which are represented in the data of that network.  ( N.B., SpaceQry establishes the 
individual frequency bands by using each assigned frequency +/- half of the bandwidth associated 
with it). 
 
As shown below, these bands are displayed in the Network listbox on the right-hand side of the 
window.  Once the list is established you may move selected bands into the list on the left-hand 
side by clicking on the Copy button .  Bands may also be removed from either list by 
selecting the band(s) and then clicking on the associated Remove button .  Once any band 
is removed from the Network list, the list can be fully regenerated by clicking on the Reload button 

. 
 

 
 

Include Network Frequencies  Area 
 
Once a target network has been specified and the associated list of network frequencies has been 
generated, the three radiobuttons associated with the network frequencies are enabled.  These 
buttons essentially tell SpaceQry how to use the frequency bands listed on the right in conjunction 
with the frequency bands which you may have entered on the left.  The function of these buttons is 
as follows: 
 

• Yes    this option tells SpaceQry to use all frequency bands which are 
currently in the Network List  in addition to any frequency bands which you may have 
entered on the left.  In other words, to use both lists. 

• No    this option tells SpaceQry not to use the Network frequencies in 
conjunction with the frequencies listed on the left.  In other words, to only use the bands 
which you have entered or which you have copied from the Network list. 

• As logical AND this option tells SpaceQry to produce a Boolean intersection between 
the frequencies of the two lists.  This option is particularly useful when you are only 
interested in querying based on frequency bands relating to a Radio Regulation (a good 
example would be checking for frequency bands subject to Resolution-46 ). 

 
Although the frequency criterion is optional for Standard Queries; for obvious reasons, at least one 
frequency band must be specified for all Overlap Queries. 
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Locating the Notice-ID of a Satellite or Earth Station 
 
As of SpaceQry version 2.5, a feature has been added to both the Frequency Tab and the Quick 
Query Tab  which allows you to locate a BR network ID by supplying a satellite name.  To invoke 

this feature, click on the  button immediately to the right of the ID field as shown below: 
  

 
 
This action will invoke a Criterion Value List window for satellite names.  After locating and 
selecting the desired satellite from the list, one of two things will happen:  if there is only one notice 
which corresponds to the satellite name, the corresponding notice-ID will be inserted directly into 
the ID field (on the appropriate tab); if, however, more than one notice corresponds to the satellite 
name, then a second criterion value list window will be invoked which shows all corresponding 
notices (as shown in the example below).  The desired notice can then be selected. 
 

             
 
 
In either case, the notice-ID corresponding to the selected notification will be inserted directly into 
the ID field, as shown in the continuation of the example below: 
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The Overlap Criteria Tab 
 
The Overlap Criteria Tab lists all querying criteria which specifically relate to Frequency Overlap 
and Frequency Slot Queries (and, consequently, is only available when the Overlap Query Type 
has been selected).  The tab is divided into two areas: the upper area relating to the four overlap-
specific criteria and the lower area relating to how the results of the query should be compiled and 
displayed.  Each of these items is discussed separately below. 
 
 

 
 
 

Beam  Criterion 
 
The Beam Criterion allows you to restrict your search for overlapping frequencies to those present 
in either transmitting or receiving beams.  To impose this restriction, using your pointing device, 
you must click on the desired beam type so that the associated checkbox is “checked.”  Since 
there are only two possible values for this criterion, if neither box is checked, it implies that the 
beam criterion is not considered, and therefore is (roughly) equivalent to both boxes being 
checked.   
 
 

Group-level Publication Number  Criterion 
 
The Group-level Publication Circular number is a criterion which allows you to locate all groups 
which were published in a specific Weekly Circular (through December 1999) or International 
Frequency Information Circular, or IFIC, (from January 2000).  You should enter into this field one 
or more 4-digit values, separated by commas.  To specify a range of circular numbers, enter two 
values separated by the double symbol ".."  or  the word  "to"  . You may also specify multiple 
(single) values and ranges separated by commas.  
 
As an example, to select all groups published in Space Weekly Circulars before number 2400,  
enter:         0 to 2399     
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Group-level Findings Criterion 
 
The term Findings here refers specifically to the Regulatory finding given to a frequency group of a 
notice. A finding is either favorable or unfavorable, but also for internal BR users, the finding of 
some groups may not yet have been specified. For the type of findings, you may select one or 
more of the three findings types (favorable, unfavorable, or unspecified) by “checking” the 
associated checkbox(es). The default is for all findings types.   

 
Overlap Date  Criterion 
 
The Overlap Date Criterion allows you to specify a date and optionally specify a before or after 
condition in your search for overlapping frequencies.  The actual type of date is dependent on 
whether the final results are based on Networks or on either Groups or Frequency Assignments 
(see below).  When the final results are based on Networks, the date criterion refers to the 
network-level field Date of Receipt, and alternatively, when the final results are based on either 
Groups or Frequency Assignments, the date criterion refers to the group-level field Date of 
Protection. 
 
To specify a date criterion, using your pointing device you should first select the desired Final 
results based on… value by clicking on the radio button associated with the desired value.  This 
action will setup the corresponding Date Criterion label.  At this point, you should enter the desired 
date in your local short-date format (eg, mm/dd/yy, dd.mm.yy, etc.), and optionally select the radio 
button associated with either On or before or On or after  as desired.  Note: if a date is specified 
without a before/after condition, then the query will look for exactly matching dates only. 

Clicking on the  button will automatically insert today’s date into the date criterion field, while 

clicking on the  button will clear both the date field and the date-condition radio buttons. 
 
 

Overlap Query Final Results 
The results of a Frequency Overlap Query can be organized and displayed in four different ways: 
based on Networks, Networks plus a Sample Frequency, Groups, or Assigned Frequencies. 
    

• Selecting the Networks option will first return a list of all networks which contain overlapping 
frequencies (subsequent navigation can list the actual overlapping frequencies for a 
selected network);    

• selecting  the Networks plus option will return a list of all networks which contain at least 
one overlapping frequency, along with the first overlapping frequency encountered for each 
network during the search. The beam identifiers and group IDs of the sample frequencies 
are also included in the results;   

• selecting the Groups option will return a list of frequency groups which contain overlapping 
frequencies;  and   

• selecting the Assigned Frequencies option will return a list of all  overlapping frequencies 
with respect to the other criteria.  NB!  You are cautioned that this last result option can 
very easily return an extremely large and unmanageable set of data.  It is not 
recommended unless the other criteria specified will considerably narrow the scope of the 
query.  
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Overlap Query Sorting Order 
 
SpaceQry automatically specifies the eight most frequently requested sorting orders for Overlap 
Queries.  Each of these are described below; however, it should be noted here that any other 
sorting order can be specified by editing the order by clause of the SQL statement generated by 
your criteria.  For more information on how to edit the SQL statement, please see the Adhoc Query 
Tab section in this chapter.  The supplied sorting orders are: 
 

• BR Identification    : sorted by BR identification number; 
 
Specifically for network-level overlap queries: 
 

• Administration    : sorted by administration code, satellite name & notification reason; 
• Orbital Position   : sorted by nominal longitude, administration code and organization; 
• Adm Identification   : sorted by administration code & administration reference ID; 
• Notification reason   : sorted by notification reason, administration code & satellite name; 

 
Specifically for group- or frequency-level overlap queries: 
 

• Beam Name    : sorted by Network name, emission-reception flag, & beam name; 
• Group Identification  .: sorted by BR group ID and frequency; 
• Date Protected   : sorted by descending date of protection (2D) & BR group ID. 

 
To select a sorting order, simply click on the associated radio button.
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The Quick Query Criteria Tab 
 
The Quick Queries Tab lists a number of pre-defined, specialized queries (usually) returning 
specific information about a given Network.  These queries were given the name quick because 
they require a very minimal number of criteria parameters (in some cases only the network ID), 
and therefore, are easy or quick to specify and run.  Although these queries have evolved from the 
engineering and administrative requests and needs of the Space Services Department of the BR, it 
is assumed that they will be of interest to the SpaceQry users outside the ITU, as well. 
 

 
 
The Quick Queries tab is divided into two areas: the upper area contains parameter or criteria 
fields and the lower area lists the various queries available.  You will notice that as different Quick 
Queries are selected, the availability of the associated parameter fields is restricted to those 
criteria which apply to the selected query.  Also, as of the 5.3.1 release, the sliding page bar (aka, 
slider) has been replaced by topic-related sub-tabs as seen in the lower right-hand corner of the 
above illustration.  The queries are grouped by topic onto pages which are accessed by clicking on 
the associated sub-tab.  The illustration above has the Frequencies sub-tab selected. 
 

BR Network (or Notice) ID Criterion 
 
The BR Identification is the network identification number which is generated by the BR and 
assigned to each incoming notification.  You should enter into this field one or more network ID 
values separated by commas,  or a range of ID values separated by the double symbol “..” or the 
word “to”.  This field is required for most Quick Queries.  As an example, to perform a Quick Query 
against two Networks, enter:   99000001, 99000101  
 
There is also a feature which allows you to locate a BR network ID by supplying a satellite name.  
For information on finding a notice ID value, please see the section on Locating the Notice-ID of a 
Satellite or Earth Station earlier in this document. 
 

) Hint!  When a database containing a single network is selected for a Quick Query (as in the 
case for a Validation Query), SpaceQry will automatically find the network/notice ID and insert it 
into the ID field. Obviously, if the database contains more than one network, then you will 
necessarily have to select the desired network to be the object of the query. 
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Include Frequency List Criterion 
 
To include frequency ranges in a Quick Query, simply click on the  Include frequency list  
checkbox to “check” it; SpaceQry will automatically reposition the criteria window to the Frequency 
Criteria tab, and you may then enter the desired frequency range values.  To disassociate a list of 
frequencies from the query, click on the   Include frequency list checkbox a second time to 
“uncheck” it.  For information on how to enter the frequency range values, please see the 
description of the Frequency Criteria Tab in this document.  
 

Special Section Reference Criterion 
 
Special Section Reference is a symbol which indicates a specific Special Section of the Space 
IFIC publication. To specify a Special Section reference, enter one or more values into the edit 
field, comma separated.  Typical values for this field include: AR11/A, AR11/C, RES33/A, 
RES46/A, and RES46/C.  You may also enter a wild card value, like  RES*   .  The default (nothing 
specified) is to select all Special Section references. 
 

Findings Type Criterion 
 
The term Findings here refers specifically to the Regulatory finding given to a frequency group of a 
notice.  A finding is either favorable or unfavorable, but also for internal BR users, the finding of 
some groups may not yet have been specified.  For the type of findings, you may select one or 
more of the three findings types (favorable, unfavorable, or unspecified) by “checking” the 
associated checkbox(es).  The default is for all findings types. 
 

Beam Type Criterion 
 
To specify a single beam type, simply click on and “check” the checkbox associated with the 
desired beam type.  NB, checking both the Emission and Reception boxes returns the same result 
as leaving both boxes unchecked.   
 

Date Range Criterion  
 
The Date Range criterion will represent a lower and upper bound for the date of bringing into use 
(2c) or date of end of regulatory period of the target network or network frequency.  This criterion is 
a pair of date values which should be entered in your local, short date format.  As an example, to 
select networks with frequency groups having a date of bringing into use between March and 
September of 1997, Europeans would enter the two values:  01.03.2003  and  30.09.2004 ,  while 
North Americans would enter the values:  03/01/2003  and  09/30/2004 .    
 
NB: If a single date is supplied, then you will be asked to confirm the following: 
 

• If a single, from value is supplied (i.e., the to value is missing), whether your intent was to 
request a date which is on-or-after the supplied date;  or 

• If a single, to value is supplied (i.e., the from value is missing), whether your intent was to 
request a date which is on-or-before the supplied date, e.g.: 

 
(See illustration on next page) 
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Available Quick Queries 
 
As of the writing of this document for the SpaceQry version 6.0 release, the following sixteen Quick 
Queries have been identified and implemented:  They are shown by topic tab 
 

Quick Queries Specifically Relating To Frequency Ranges: 
 
Clicking on the Frequencies  sub-tab as shown here 
will display the following, frequency-related queries:  

 
 

List all (or some) frequencies for a given 
network.  This query requires as a parameter a single BR network (notice) identification 

number; optionally, you may also supply any number of frequency ranges from the Frequency 
Criteria tab.  The results of this query are sorted by the emission/reception flag, beam name, and 
group ID. 
 

List all (or some) frequencies for a given network which are unique within their beam.  This 
query requires as a parameter a single BR network (notice) identification number; optionally, 

you may also request only receiving or transmitting beams and/or supply any number of frequency 
ranges from the Frequency Criteria tab.  The results of this query are sorted by the 
emission/reception flag, beam name, and group ID. 
 

Within a given network, list all (or some) unique frequency bands followed by all associated 
classes-of-stations and beams in which they appear.  This query requires as a parameter a 

single BR network (notice) identification number; optionally, you may also request only receiving or 
transmitting beams and/or supply any number of frequency ranges from the Frequency Criteria 
tab.  The results of this query are sorted by assigned frequency and bandwidth. 

 
Frequency Summary: list all frequencies for a given network which are unique within their 
beam and class-of-station. This query requires as a parameter a single BR network (notice) 

identification number. The results of this query are sorted by the beam name, emission/reception 
flag, and frequency. 
 

"In or Out of Range" Query: for a given network, list all groups that might be subject to a 
requested 2C date extension based on a set of frequency ranges. This query requires as a 
parameter a single BR network (notice) identification number; optionally, you may also 

supply any number of frequency ranges from the Frequency Criteria tab.  The results of this query 
are sorted by the beam name, emission/reception flag, and group ID. 
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Quick Queries Specifically Relating To Resolution 49 and/or Advanced Publication:  
 
 
Clicking on the Rs49 + API sub-tab 
(as shown to the right) will display the 
following queries:  

 
 
 Resolution-49 Capture Query (non-planned services):  create a “filing database” for 
SpaceCap from a list of frequency bands with a planned 2c date between two values.  This 

query requires as a parameter one of the following three criteria: a 2C-date range, a Satellite 
name, or a single BR network (notice) identification number; optionally, you may also specify a 
Notification/Coordination indicator, an administration and/or organization code from the General 
Criteria tab; and/or Geostationary/Non-geostationary indicators and Orbital position on the Station 
Criteria tab.  The initial result of this query will be a list of networks sorted by their notice-Ids. As 
you navigate through this list, you will also find displayed in a sub-window, a list of unique 
frequency ranges for the current network which match the date criterion.   Clicking on the Create 
button will produce the “filing database” required by the SpaceCap RS49 Wizard facility  (see 
illustration immediately following this section). 
 

Resolution-49 Capture Query (planned services):  create a “filing database” for SpaceCap 
from a list of frequency bands with either a planned 2c date or an examination date between 

two values.  This query requires as a parameter one of the following three criteria: a date range (as 
an examination or 2c date), a Satellite name, or a single BR network (notice) identification 
number;; optionally, you may also specify a BSS/FSS indicator, an administration and/or 
organization code from the General Criteria tab; and/or an Orbital position on the Station Criteria 
tab.  The initial result of this query will be a list of networks sorted by their notice-Ids. As you 
navigate through this list, you will also find displayed in a sub-window, a list of unique frequency 
ranges for the current network which match the date criterion.   Clicking on the Create button will 
produce the “filing database” required by the SpaceCap RS49 Wizard facility (see illustration 
immediately following this section). 

 
List all satellites with a planned bringing-into-use (2c) date between two given dates.    This 
query, which is used to identify potential Resolution-49 cases, requires only a 2C-date 

range as a parameter.  You may further restrict the query by optionally specifying any of the 
following criteria:  Notification/Coordination indicator on the General Criteria tab; Administration 
and/or Organization codes on the General Criteria tab; Geostationary/Non-geostationary indicators 
on the Station Criteria tab; Satellite name on the Station Criteria tab; and Orbital position on the 
Station Criteria tab.  The results of this query are sorted by the 2C date, 
administration/organization, and satellite name. 

 
Within a given network, list all unique frequency bands with a planned bringing-into-use (2c) 
date between two given dates.  This query, which is used to identify potential Resolution-49 

cases on frequency groups within a given network, requires as parameters a single BR network 
(notice) identification number and a 2C-date range.  The results of this query are sorted by 
frequency and associated class of station. 
 

List satellites with an API filing containing frequency bands received between two given 
dates.  This query, which is used to identify satellites containing API frequency bands 

received in a date range (for Cost Recovery purposes), requires as parameters a Date-of-
protection range. You may further restrict the query by optionally specifying any of the following 
criteria:  Administration and/or Organization codes on the General Criteria tab; Geostationary/Non-
geostationary indicators on the Station Criteria tab; Satellite name on the Station Criteria tab; and 
Orbital position on the Station Criteria tab.   The results of this query are sorted by 
administration/organization, and satellite name. 
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 The “Date-Link” Query.  List the regulatory dates for frequency range(s) of a given satellite 
within its API – Coordination – Notification - RS49 cycle.  This query requires as a parameter a 
single, unique Satellite name on the Station Criteria tab; but, optionally, you may also supply any 
number of frequency ranges from the Frequency Criteria tab.    The results of this query are sorted 
by frequency range. 

) Hint!  When specifying criteria for this query, if you wish to specify specific frequency ranges 
relevant to the given satellite, then do the following steps in the sequence shown: 

1) select (or enter) the satellite name on the Station Tab,  
2) return to the Quick Query Tab, and then  
3) click on the Include frequencies check box.  

 
If done in this sequence, SpaceQry will “pick-up” on the satellite name and generate a list of all 
frequency ranges (as present in the satellite’s API filing).  You may then select some or all ranges 
as generated, and/or include additional ranges on the Frequency Criteria Tab. 
 
Rs49 Capture Query Results 
 
Assuming that you have entered CAN as the administration, the wildcarded value ANIK E* as the 
satellite name, and requested No Previous Submission, you would see a results window similar to 
the one in the following illustration. 
 

 
 
When more than one satellite is presented (w.r.t. the criteria specified), clicking on a row in the 
satellite list will change the results in the frequencies list.  Clicking on the button in the lower right 
hand corner of the window will create an Rs49 capture database for the SpaceCap Rs49 Wizard. 
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Quick Queries Relating To Validation, Findings, Provisions, etc:  
 
 
Clicking on the Special sub-tab (as shown to 
the right) will display the following queries 

 
 
 

Validation Query:  for a given network, display the results of the last validation run (where 
and when applicable).  This query requires as a parameter a single BR network (notice) 
identification number; optionally, you may also specify whether you wish to see only 

warning messages or only fatal-error messages; both types of error messages are the default.  
The results of this query are sorted by the beam name, emission/reception flag, group ID, 
database table name, and error number. 

 
List specified findings for all groups in a given network.  This query requires as parameters a 
single BR network (notice) identification number and a specification of which type of 

findings.The results of this query are sorted by the emission/reception flag, beam name, and group 
ID. 
 

 
List specific Special Section publications for all groups in a given network.  This query 
requires as parameters a single BR network (notice) identification number and, optionally, a 

specification of one or more Special Section references.  The results of this query are sorted by 
the emission/reception flag, beam name, and group ID. 

 
For a given network, list all administrations to which coordination has been requested.  This 
query requires as a parameter a single BR network (notice) identification number.  The 

results of this query are sorted by provision, administration code and organization code. 
 
 

For a given network, list all groups for which coordination has been requested to a given 
administration.  This query requires as parameters a single BR network (notice) identification 

number and a specification of administration and/or organization against which to check.  The 
administration and/or organization code must be entered on the General Criteria tab.  The results 
of this query are sorted by emission-reception flag, beam name, and group ID. 
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Quick Query CueCard 
 
When selecting a query from the Quick Query tab, SpaceQry automatically presents a CueCard  
which lists both the required and optional criteria for the selected query.  The following is an 
example of the cuecard produced for the Frequency List  query: 
 

 
 
The presence of these cuecards may be suppressed at any time by clicking on and “unchecking” 
the   Show this CueCard next time box, and then clicking on the  button.  After doing this 
the cue card facility can be re-instated by selecting the Show Cue Card  option from the context 
menu which is produced by right-clicking the pointing device over an area of the Quick Query tab 
window.   
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The Plan Criteria Tab 
 
 All criteria and querying abilities common to the other notification types are valid and useable 
with the Plan data; and, as seen below, you may query further based on specific Plan identifiers 
and channels. 
 
Currently, the tab is divided into four areas: the first relating to Broadcasting Satellite Services 
(BSS Plans); the second relating to Fixed Satellite Services (FSS Plans); the third relating to 
notices submitted under articles 2A of Appendix 30 and 30A regarding the use of guardbands to 
provide Space Operation Functions for BSS Plans; and the fourth relating to specifying channels.  
Each of these criteria is discussed separately below. 
 

 
 

Plan ID Criterion 
 
The Plan Identification is a BR code which represents a specific Plan.   As a result, this criterion 
allows you to identify networks which are associated with specific Plans within the Broadcasting 
and/or Fixed services.  You may specify one or more Plans by checking the associated box(es).  
The individual Plans are described as follows: 
 

• Broadcasting Satellite Services Plans 
o RARC BC SAT83 for Region 2 : Appendix 30 plan for broadcasting services 

within Region 2 operating in the frequency band 12.2 - 12.7 GHz. 
o WRC-2000 Down-link for Regions 1 and 3 : Appendix 30 plan / Resolution 

542 list for down-links in the frequency bands 11.7 - 12.5 GHz within Region 1 
and 11.7 - 12.2 GHz within Region 3. 

o WRC-2000 14/17 GHz Feeder-link for Regions 1 and 3 : Appendix 30A plan / 
Resolution 542 list for feeder-links in the frequency band 14.5 - 14.8 GHz or in 
the frequency band 17.3  - 18.1 GHz within both Regions 1 and 3. 
 

• Article 5 of the Broadcasting Satellite Services Plans relating to the notification of 
frequency assignments to satellites in the Broadcasting Satellite Service. 
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• Fixed Satellite Services Plans 
o WARC ORB-88 6/4 GHz Band : Appendix 30B plan for fixed services 

operating feeder-links in the frequency band 6.725 - 7.025 GHz, and down-
links in the frequency band 4.5 - 4.8 GHz. 

o WARC ORB-88 13/10-11 GHz Band : Appendix 30B plan for fixed services 
operating feeder-links in the frequency band 12.75 - 13.25 GHz, and down-
links in the frequency bands 10.7 - 10.95 GHz and 11.2 - 11.45 GHz 
 

• Article 8 of the Fixed Satellite Services Plans relating to the notification of frequency 
assignments to satellites in the Fixed Satellite Service. 

 

Article 2A Criterion 
 
When selected (checked), the Article 2A criterion tells SpaceQry to identify notices which have 
been submitted under Article 2A of either Appendix 30 or Appendix 30A, both of which are 
regarding the use of guardbands to provide Space Operation Functions for BSS Plans. To look for 
these notices simply click on the  Notices submitted under Article 2A… checkbox leaving it in a 
“checked” state; to remove the criterion, click again leaving it in an “unchecked” state. 
 

Channel Criteria 
 
Specifying one or more channels in a query is an extension of specifying frequency ranges for your 
query; i.e., at execution time, a channel specification will be converted into the frequency range 
represented by that channel’s center frequency and the associated channel bandwidth. 
 
By default, the  Standard checkbox will be checked, and the Plan Tab will be in Standard 
Channel mode.  This means that as you select one or more plan values in the BSS Plans group, 
the Available channels list on the right will fill up with standard channel information relating to the 
plan(s) selected.  You can include any of these Available Channels for your query by selecting the 
row in the Available channels list and clicking on the Copy to my list button [Å ] located between 
the two lists.  A channel can be removed from your list at any time by selecting its row and clicking 
on the Remove from my list button [ X ]. 
 
Unchecking the  Standard checkbox will set the Plan Tab to Non-Standard Channel  mode, 
which allows you to specify your own channels by 1) entering a hypothetical center frequency for 
channel number 1;  2) entering a channel-spacing value in MHz;  3) entering a channel-bandwidth 
value in MHz; and 4) clicking on the Calculate channels button [ ! ].  In the illustration shown below, 
channel data has been calculated using a channel-1 center frequency of 14525.0 MHz, channel 
spacing of 25.0 MHz and channel bandwidth of 30.0 MHz.  As with standard channel data, these 
channel specifications can be included in the query by copying a selected channel from the list on 
the right into the list on the left, using the Copy to my list button [Å ]. 
 

 
 
A query can include both standard and non-standard channels – non-standard channels are 
shown with an asterisk, e.g., 03*.
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The Adhoc Query Tab 
 
 The Adhoc Query tab allows you to either edit the SQL statement which is generated by your 
specified criteria, or to create your own query against any BR Space Frequency Management 
(SNS-format) database.  This tab is only visible when you have selected the Adhoc Query type 

from the Query Type Tab,  or when you have clicked on the Edit SQL  button during the 
specification of a standard, overlap, or quick query.   
 

 
 
 
The Adhoc Query tab is divided into 3 areas, each of which is described as follows: 
 
 

SQL Statement Area 
 
This text-editing field at the top of the tab is the area into which you should type your SQL 
statement.   This editing area is completely freeform and will automatically wrap text to the next 
line without a carriage return.  You may use either upper- or lower-case letters or a combination of 
the two.  However, and NB! you should be aware of the case requirements of the database 
management system associated with the database against which you are querying!   While 
Microsoft Access will treat  adm=’usa’ and adm=’USA’ as equivalent requests, however, Ingres 
would not.  Since most alphanumeric data in the SRS databases is upper-case, the condition  
adm=’usa’ would give no results if specified on an Ingres database. 
 
 

Available Tables and Related Fields Area 
 
As its name implies, the Available tables  listbox in the lower left-hand corner of the tab contains 
the names of all tables contained in the currently selected database; once a database is opened, 
the contents of this listbox are static.  The second listbox, entitled Related fields contains a sorted 
list of all fields, or columns, contained in the table which is currently selected;  consequently, as 
you navigate within the table list, the contents of the fields list will change.  
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You may use these two listboxes simply for reference, or you may insert the table and field names 
into your SQL statement by double-clicking on the desired item.  The insertion will take place at the 
current location of the editing cursor within the edit field.   
 
As an example, if you have just typed “select * from   “  into the edit area, and you then double-
click on the com_el  table name in the tables list, the edit area would then read  “select * from  
com_el “.  Likewise, if you have just typed “order by “ on a new line in the edit area and then 
double-click on the adm field name in the fields list, the new line would read  “order by adm ”. 
 
Also, by checking the  Qualified Insertion box at the very bottom of the tab, all inserted field 
names will be qualified by their owner table name.  Using the previous example when the Qualified 
Insertion box is checked, if you have just typed “order by “ on a new line in the edit area and you 
then double-click on the adm field name in the fields list (which is associated with the com_el 
table), the new line would read:  “order by com_el.adm ”. 
 
You will also find a  Use as a Macro Query box at the bottom center of the tab.  Checking this 
box tells SpaceQry to interpret the contents of the SQL edit area as a multi-step query, or Macro 
Query.  For more information on Macro Queries, see the section entitled SpaceQry Macro Query 

Facility below.  The same information is also available by clicking on the  Macro Query Info 
button located next to the checkbox. 
 
 

SQL Template Area 
 
In the lower right-hand corner of the tab, you will find a set of radiobuttons that will generate SQL 
statement templates within the SQL statement area.  The desired template, each of which is 
discussed below, can be inserted into the SQL statement window by clicking on the associated 
radiobutton. 
 

• Freeform   the basic SQL structure:   select… from… where… order by… ; 
• Standard Network the statement framework for a Standard Query; 
• Network Overlap the statement framework for a Network-level Overlap Query; 
• Group Overlap the statement framework for a Group-level Overlap Query; 
• Frequency Overlap the statement framework for a Frequency-level Overlap Query; 
• No Template  no template is supplied; the SQL statement area is empty. 

 
The best way to become familiarized with the different templates is to click on the various 
radiobuttons and observe what partial statement is generated.  However, you should be aware that 
changing templates in the middle of specifying an SQL statement will overwrite (i.e., destroy) any 
typing which you might have already done in the statement area! 
 
You will also notice that the SQL Template buttons are not available when editing an SQL 
statement which has been generated by SpaceQry.  This is so you cannot accidently overwrite the 
statement which contains references to your selected criteria fields.  The SQL Template buttons 
are intended for use exclusively with the creation of an Adhoc SQL Query. 
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Using Parameters in the SQL Statement 
 
There is often a need for a special SQL query to be repeated several times, each time changing 
the value of one or more variables.  An obvious example of this would be to have a query for which 
each iteration would require a different notice ID; or perhaps, a change of frequency range.  This 
can be implemented by substituting a variable prefixed by an ampersand character (&) in the 
appropriate place in the SQL text.  The following are two simple examples:   
 

select beam_name,emi_rcp, ant_type from s_beam where ntc_id = &myNotice    
or 

select * from geo where sat_name like ‘&mySat’ order by ntc_id   
  
In the first example, the variable &myNotice represents a numeric parameter, and in the second 
example the variable &mySat represents an alphanumeric, or character parameter. 
 
 
When an SQL statement containing one or more 
parameters is executed, SpaceQry will ask you to 
supply values for each parameter encountered.  The 
figure to the right shows the parameter-substitution 
window resulting from the first example.  At this point 
you would enter a notice ID value into the text field and 
then click the pointing device on the Replace button.  
The value would then be substituted and the SQL 
immediately executed.  In the event that an ampersand 
character is actually part of the data (and, hence, not 
identifying a parameter), clicking on the Ignore button 
will leave the occurrence exactly as it is.  To halt the 
substitution process and return to the Adhoc Query tab, 
click on the Cancel button 
 
NB, no validation is done on any value entered. 
 

Using Special Characters in the SQL Statement 
 
From time to time, and sometimes without design, a database table can contain unprintable and 
non-viewable characters such as tabs and line-feeds.  As an example, this can easily happen 
when data is improperly imported into MS-Access from a spreadsheet format.  The ability to locate 
(and correct) such data is not an easy task, even with tools like MS-Access.  The SpaceQry Adhoc 
Query Facility has been extended to provide a mechanism to locate this kind of data by the use of 
two new character functions, ^chr() and ^hex().    
 
The ^chr() function take as a parameter a numeric value between 1 and 255, and will return the 
ASCII character associated with that number; e.g., ^chr(8) will return the tab character or ^chr(10) 
will return a soft line-feed character, while ^chr(10) ^chr(13) will return a hard line-feed (line-feed 
followed by a carriage-return). 
 
The ^hex() function is similar, but takes as a parameter any number of valid hexadecimal pairs 
and returns the associated string of character(s); e.g., ^hex(0A0D) or ^hex(0A 0D), as above, will 
return a hard line-feed (line-feed followed by a carriage-return). 
 
As an example of usage, suppose you have satellite names in the geo table which contain tab 
characters.  To locate these records you would use either of the following SQL statements: 
 

select * from geo where sat_name like ‘%^chr(8)%’ 
or  select * from geo where sat_name like ‘^hex(25 08 25)’ 
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The SpaceQry Macro Query Facility 
 
A Macro Query as defined by the SpaceQry software, is a query which consists of two or more 
steps or actions. It is a multi-stage, or multi-step query which is usually defined and used when the 
desired end results of a query require processing on the results of a previous query (much like the 
Macro facility of MS-Access) - this also usually requires the creation of temporary tables 
(sometimes called Views).  Since it is the nature of SpaceQry to query from SRS and IFIC 
databases and not update them, all temporary tables are required to be located elsewhere (eg, in 
temporary databases).  Please note that you will not be allowed to update any IFIC or SRS 
database using the Macro Query facility.   
 
All macro steps, or statements, must consist of a keyword followed by an equal sign ( = ), followed 
by the associated command or descriptor, and terminated with a semicolon ( ; ).  Each step should 
be of the following form: 
 

KEYWORD = command line or descriptor ; 
  
The keyword values are described as follows: 
 
CAPTION - this indicates text to be displayed in the caption (or title bar) of all subsequent  data 

windows. Typically, this would describe the results of an SQL select statement.    
 
DIRECTORY - see description of FOLDER. 
EXECUTE - see description of RUN. 
 
FOLDER - this statement declares a directory or folder to SpaceQry which should be used as 

a search path for locating files.  It, however, does not change the current directory 
or drive of the system. The format of this statement is one of the following: 

 
FOLDER = SRS; 
FOLDER = WIC; 
FOLDER = IFIC; 
FOLDER = NSL; 
FOLDER = TEMP; 
FOLDER = any valid directory/folder path (eg, c:\my folder\databases); 

 
If the SRS descriptor is used, then SpaceQry will set your system’s default location 
for SRS databases* as the search path. 
 
If the NSL descriptor is used, then SpaceQry will set your system’s default location 
for NSL databases* as the search path. 
 
If the WIC or IFIC descriptor is used, then SpaceQry will set your system’s default 
location for IFIC databases* as the search path. 
 
If the TEMP descriptor is used, then SpaceQry will set your system’s default location 
for temporary databases* as the search path. 
 
*These default locations are set on the Paths tab of the SpaceQry Preferences 
dialogue. 
 
The user can also specify any valid directory or folder path. 

 
IFCONTINUE 
 
IFSTOP 
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INFORMATION - this indicates text to be displayed to the user within a pop-up textbox.  It can be 
used to pass instructions, relay directions, or to indicate formatting, etc.   

 
 
PARAMETER - this keyword specifies an in-line parameter substitution which will take place when 

the macro query is run, and is, in fact, an extension of the parameter substitution 
used in the Adhoc Query facility of SpaceQry  This macro step should be in the 
form: 

 
   PAR=Aaa=bbb ;  
  or PAR=Aaa=? ; 
 
  where Aaa  is the parameter name and bbb is the parameter value to be 

substituted.  The Macro Query processor will look for all subsequent occurrences of 
the string &Aaa within the macro code, and substitute the value bbb.   NB, the 
substitution search on parameter name is case sensitive; so, as in the format 
statement referred to above,  AAA  would not be recognised in a search for Aaa. 
When the form Aaa=? is used, as with normal Adhoc Query parameters, you will be 
asked to supply the value at run time - the difference here is that the substitution will 
be implemented globally for all occurrences of &Aaa from the point of encounter to 
the end of the Macro Query specification. 

 
  For more information on paramenter substitution within SQL statements, please 

see the Adhoc Query section of the SpaceQry Query Guide. 
 
REMARK - this denotes a documentational comment.  All text after this keyword and up to the 

next semicolon will be ignored when the macro query is run. 
 

RUN -  this statement  will run or execute an external program. You may also, optionally, 
specify the program with parameters.  Unless the program is in the search path, the 
file name should be fully qualified.  Some examples of this statement are: 

 
RUN=notepad.exe c:\br_soft\data\mystuff.txt; 
RUN=c:\program files\my software\myProg.exe myParam1, myParam2; 

 
SQL  - this statement indicates text to be used as an SQL statement. It can include any 

number of parameters as specified in the Adhoc Query section of the SpaceQry 
Query Guide.  Each parameter which is not referenced in a PARAMETER statement 
prior to its occurrence, will be identified by the Adhoc Query processor when the 
macro query is run, and the user will be asked to supply a value for it.  

 
 
WORKDB - this is a special form of the PARAMETER statement which is required if the Macro 

Query requires interim results (ie, intermediate tables) to be written.  SpaceQry will 
not allow a user to update the data within an SRS database, so if a Macro Query is 
to perform a query on the results of a previous query, then the results of the first 
query must be written into a working database.  The format of this statement is one 
of the following: 

 
   WORKDB = auto ; 
   WORKDB = ? ; 
   WORKDB = fully qualified database file name  (eg, c:\temp\mydb.mdb) ; 
 
  If the auto descriptor is used, a temporary file will be created by SpaceQry (as 

needed) and then deleted at the end of the process. 
 
  If the question mark ( ? ) descriptor is used, the Macro Query processor will ask 

the user to browse and specify the work file when the macro query is run.  This file 
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will not be deleted automatically.  This option will be useful when the user wants the 
results of a macro query to be stored in a database for other uses. 

 
  Obviously, the user can specify a file name for the WORKDB as well.  This 

database file need not exist before the query is run;  if not found, SpaceQry will 
create it at run time. 

 
YNBOX - this is a special statement that will produce a dialogue box with Yes/No options.  

The result of the YesNoBox is a Boolean (represented with the keyword  REPLY) 
which can be tested.  The format of the statement is as follows: 

 
YNB=text to be inserted into dialogue box;  

 
  Both of the following examples of this statement will display a dialogue box 

asking the user if they wish to continue.  If a ‘no’ is returned, then the macro 
terminates. Although both forms are essentially equivalent, the second differs in that 
the test for the value of REPLY can appear later in the macro: 

 
IFC=YNB=No results are found. Do you wish to continue?;  

or 
YNBOX= No results are found. Do you wish to continue?; 
IFC=REPLY=TRUE 
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Working Example:   Compute expiration of validity (supply target date at run time)     
 
The following lines represent an actual Macro Query which is being used in the BR.  The lines 
represented in blue are macro steps, and the lines represented in red are comments on the macro 
step immediately preceding them, and hence, should not be used in the Macro Query specification.   
 

rem=This query extracts all notices which have at least one frequency group whose validity will expire 
based on a date which is supplied at run time; 

  )  for documentation only: remarks are ignored at run time... 
 

info=NB: Always remember to specify a new database!; 

  )  prompt to the user at run time... 
 

workdb=?; 

  )  The user will be allowed to select output database at run time... 
 

info=Remember to always specify dates as YYYY/MM/DD, eg., 2002/05/25; 

  )  prompt to the user at run time... 
 

sql=SELECT adm , ntwk_org , c.ntc_id , sat_name , grp_id, d_inuse , prd_valid, 
DateAdd('yyyy',prd_valid,d_inuse) AS d_Validity, #&TargetDate# AS d_Target INTO validityWork IN 
'&workdb' FROM com_el AS c, grp AS g WHERE ntc_type='G' and ntf_rsn='N' And c.st_cur='50' and 
c.ntc_id=g.ntc_id and prd_valid Is Not Null ORDER BY adm, ntwk_org, c.ntc_id, grp_id; 

  )  The SELECT INTO query creates the table validityWork in the work database. 
  The user will be asked to supply the TargetDate value at run time... 
 

sql=SELECT * INTO validity IN '&workdb' FROM validityWork IN '&workdb' WHERE 
d_validity<d_Target ORDER BY adm, ntwk_org, ntc_id, grp_id; 

  )  The SELECT INTO query creates the table validity in the work database... 
 

cap=All Groups Found in Validity Table; 

  )  Specifying a caption for the display of next select statement... 
 

sql=SELECT * FROM validity IN '&workdb' ORDER BY adm, ntwk_org, ntc_id, grp_id; 

  )  This query displays all groups from the validity table in the work database... 
 

ifc=ynbox=Do you wish to produce a sample group listing (first group found for each network)? ; 

)  Asking if  user wants to produce 2nd result.   
       If user answers “no”, processing stops, if “yes”, the macro continues... 
 

cap=First Group Encountered for Each Network Found in Validity Table; 

  )  Specifying a caption for the display of final select statement... 
 

sql=SELECT [adm], [ntwk_org], [sat_name], first([ntc_id]) AS noticeID, first([grp_id]) AS grpID, 
first([d_inuse]) AS d__inuse, first([prd_valid]) AS prd__valid, first([d_Validity]) AS d__Validity FROM 
validity IN '&workdb' GROUP BY [adm], [ntwk_org], [sat_name] ORDER BY [adm], [ntwk_org], 
[sat_name]; 

) This query displays the first group encountered for each network in the validity table in  
the work database... 
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 An example of the results for this query (using a date of 31 October 2003) is as follows: 
 
 
When executing this Macro Query, the user is first reminded to always select a new database file: 
 

 
 

 
The user then selects a temporary database file: 

 

 
 

 
And then confirms that the database file should be created: 
: 

 
 

 
A friendly reminder is given to assure the correct date format: 
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Then the date parameter is requested and supplied to the query: 
 

 
 

 
The Macro Query executes the first three SQL statements as defined and then produces the first 
report with the specified caption in the title bar: 

 

 
 
 

After producing the first report, the user is asked if the second report is desired: 
 

 
 
 

Answering  “No” at this point will stop the processing with only the first report produced:  
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However, answering “Yes” will produce the second report with the specified caption in the title bar: 
 

 
 
 

As with all other query types the results of Macro Queries can be printed; saved as html or text 
files; exported as MS-Excel spreadsheets; or exported as MS-Access database tables.  
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A Special Note For BR Internal Users: Using the Macro Facility With Ingres 
 
The Macro Facility can also be used on the Ingres SNS databases; there is, however, a major 
exception to the description above which can actually make the creation of temporary tables 
easier.   Ingres does not allow the direct export (or import) of data to external databases - this 
implies that temporary tables must reside in the Ingres database itself, and this can be 
accomplished by creating the desired temporary tables using the DECLARE GLOBAL 
TEMPORARY TABLE  clause. The format of the declare statement is as follows: 
 
  DECLARE GLOBAL TEMPORARY TABLE session.newTable AS 
   Select statement ...  
  ON COMMIT PRESERVE ROWS  WITH NORECOVERY; 
 
The select statement can be any normal SQL select statement as would be used in an INSERT  
statement, but cannot contain the SORT BY clause.  The special qualifier session is required to tell 
Ingres that the temporary table will be associated with the current logon-on session, and as such, 
will be automatically deleted when the user logs off of Ingres.  With this in mind, the above 
example for an Ingres based Macro Query, would translate to the following: 
 

rem=This query extracts all notices which have at least one frequency group whose validity 
will expire based on a date which is supplied at run time; 

)  for documentation only: remarks are ignored at run time... 
 
info=Remember to always specify dates as YYYY.MM.DD, eg., 2002.05.25; 

)  prompt to the user at run time... 
 
sql=DECLARE GLOBAL TEMPORARY TABLE session.validityWork AS 
 SELECT adm , ntwk_org , c.ntc_id , sat_name , grp_id, d_inuse , prd_valid,  
DateAdd('yyyy',prd_valid,d_inuse) AS d_Validity,  '&TargetDate' AS d_Target  
FROM com_el AS c, grp AS g WHERE ntc_type='G' and ntf_rsn='N' And st_cur='50' and 
c.ntc_id=g.ntc_id and prd_valid Is Not Null ORDER BY adm, ntwk_org, c.ntc_id, grp_id 
ON COMMIT PRESERVE ROWS WITH NORECOVERY; 

)  The DECLARE TEMP.statement creates the table session.validityWork in the Ingres 
database.   The user will be asked to supply the TargetDate value at run time... 
 
sql=DECLARE GLOBAL TEMPORARY TABLE session.validity AS 
SELECT * FROM session.validityWork WHERE d_validity<d_Target ORDER BY adm, 
ntwk_org, ntc_id, grp_id ON COMMIT PRESERVE ROWS WITH NORECOVERY; 

)  The DECLARE TEMP... statement creates the table validity in the Ingres database... 
 
sql=SELECT * FROM session.validity ORDER BY adm, ntwk_org, ntc_id, grp_id; 

)  This query displays all groups from the validity table in the work database... 
 
sql=SELECT [adm], [ntwk_org], [sat_name], first([ntc_id]) AS noticeID, first([grp_id]) AS 
grpID, first([d_inuse]) AS d__inuse, first([prd_valid]) AS prd__valid, first([d_Validity]) AS 
d__Validity FROM session.validity GROUP BY [adm], [ntwk_org], [sat_name] ORDER BY 
[adm], [ntwk_org], [sat_name]; 

)  This query displays the first group encountered for each network in the   
validity table in the work database... 
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The Stored Queries Tab 
 
The Stored Queries tab contains a list of all queries which you have saved using the SpaceQry 
software package.  For each of these query specifications, the list displays the query type 
(standard, overlap, quick, or adhoc), the query name and any associated comments you may have 
supplied, and a flag telling whether or not the generated SQL statement has been modified. 
 

 
 
 

Selecting a Stored Query Specification 
 
To select, or recall one of your stored query specifications, you may do one of the following: 
 

• using your pointing device, double-click on the desired row; 

• using your pointing device, click on the row and then on the select  button which 
is located on the left side at the bottom of the Query Criteria window; 

• using the keyboard, navigate to the desired row using the up/down cursor keys, and then 
hit either Alt+L (the hotkey for the Select  button) or the © Enter key. 

 
In each case, the stored query specification data relating to the selected query will be “loaded” into 
all of the relevant criteria fields.  In the case of Adhoc queries and all “SQL-edited” queries, 
SpaceQry will automatically load and display the Adhoc Query Tab displaying the stored SQL 
statement.   At this point, you may immediately issue the query or change any of the criteria fields 
(or the SQL statement) before querying. 
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Deleting a Stored Query Specification 
 
To delete a stored query specification, select the desired query row in the table and either click on 

the delete  button which is located on the left side at the bottom of the Query Criteria 
window, or type Alt+D (the hotkey for the Delete button).  You will be asked to confirm the deletion. 
 
 

Modifying a Query Specification’s Name or Description 
 
To modify the name and/or description of a stored query, select the desired query row in the table 

and either click on the Edit  button which is located on the far left side at the bottom of the 
Query Criteria window, or type Alt+I (the hotkey for the Edit Info button).  SpaceQry will respond by 
displaying the following dialogue: 
 

 
 

After modifying the contents of the Name and/or Comments fields, click on the  button to 

make the modifications to the query specification or on the  button to ignore the changes.   

Selecting the Delete  button from this dialogue is equivalent to selecting the Delete  
button on the Criteria window (see above). 
 
When saving an AdHoc or Macro Query, or saving specific querying values for a Quick Query, on 
the “Save Query As…” window you will notice a new checkbox  entitled “Favorite Query” 
located just above the “OK” button as shown in the illustration above. 
 
Clicking on this checkbox will toggle 1) the designation of the associated Saved Query as your 
favorite query and 2) the display of a group of radiobuttons and another checkbox.  When Favorite 
Query is selected, you are then asked for two additional bits of info: the first is to specify where to 
look for the targeted database.  The values SRS, NSL, and IFIC relate to the directories/folders 
associated with the same values which are set on the “Paths” tab of the SpaceQry preferences 
dialogue.  The second item is to specify whether or not to immediately execute the query.   See the 
illustration directly following for further explanation. 
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If the Favorite Query box  is checked, when the OK 
 

 button is selected, then SpaceQry 
will save the information and allow you to later recall and run this query directly by selecting the My 
Favorite Query option from the Utilities menu of the SpaceQry shell window as shown below. 
 
 

 
 
Filtering Saved Queries Based On Query Type 
 
By default all stored queries are shown in the Saved Queries list.  Over time some users may 
develop a large collection of saved queries of various types, and in this event, it may be desireable 
to filter the display of saved queries.  You will find a series of radio buttons at the bottom of the 
Saved Queries Tab, located just above the action buttons. These buttons allow you to filter the list 
of queries based on their query type.  For example, clicking on the Quick button will cause 
SpaceQry to display only your saved Quick Queries in the list. 
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Querying Examples 
 

Quick Query Example: Resolution-49: Satellites in a 2C Date Range 
 
 
Display all USA/IT geostationary satellites which are in coordination and which have frequencies 
with an associated date of bringing-into-use between July 1st 1998 and January 1st 1999. 
 

 
 
 
First, enter the two date range values into the date range fields as shown above.  The dates 
should be entered in your local (short date) format; 
 
 
 

 
 
 
Next, on the General Criteria Tab, select the   Satellite Coordination  checkbox; enter USA into 
the Administration edit field; and then enter IT into the Organization  edit field as shown above. 
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Lastly, on the Station Criteria Tab, select the   Geostationary Satellites checkbox.   Note that 
you could further restrict your search by entering a value for either Satellite Name or Orbital 
position range on this tab as well.  
 
 

To execute the query, click on the query button  or type Alt+Q.  This query request will yield 
the following result: 
 
 

 
 
As with all SpaceQry detail windows,  this information can be printed and/or saved as either Fixed-
length or Delimited Text 
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Quick Query Example: Resolution-49 Frequencies in a 2C Date Range 
 
Display all (Resolution-49 related) frequency bands for the Network 93520096 which have an 
associated date of bringing-into-use between July 1st 1998 and January 1st 1999. 
 

 
 
Enter the network ID and two date range values into the date range fields as shown above.  The 
dates should be entered in your local (short date) format; 
 
This query request yields the following result: 
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Using the Query Results 
 
In addition to printing the results of a query, or printing a snapshot of the query-result window, 
there are several ways to export or save the results of a query for archiving or for importing into 
other programs or documents. 

 

Exporting Query Results As Text 
 
Query results can be exported as text to fixed text files (possibly to be used as input files to other 
programs); to delimited text files (to be used as import files for spreadsheet programs); or to HTML 
files (to be displayed with an Internet browser or inserted into an e-mail or other document).  To 
save the query results as text, select the desired option from the Save query results as text… item 
fround in the File menu as shown below: 
 

 
 
 

Saving as a fixed or delimited text file 
 
To save the results to a text file, from the File menu of query results display, select the Save query 
results as text to: A fixed/delimited text file option. This will produce the results in either a fixed-
length format for use, as an example, as input to a FORTRAN program; or in a  (semicolon) 
delimited format for importing into a spreadsheet document. If the target file does not exist, 
SpaceQry will create it.  If the file already exists, SpaceQry will ask if the existing data in the file 
should be overwritten or appended to.   

 
Saving as an HTML document 

 
To save the results to an HTML document, from the File menu of query results display, select the 
Save query results as text to: An HTML document option. This will produce the results in HTML 
format, save them under a specified document name, and (optionally) display them in your default 
Internet browser. 
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Exporting Query Results As Data 
 
Query results can also be exported as data to MS-Excel spreadsheet files or to other database 
tables within a MS-Access database.  To do either of these, select the desired option from the 
Export query results as data to… item found in the the File menu as shown below: 
 

 
 

Exporting as a database table  
 
To save the data into a database table, from the File menu of query results display, select the 
Export query results as: A MS-Access database table option, SpaceQry will respond by asking you 
to select a target database; if the database does not exist, it will be created for you, and if it does 
exist, you will be asked to verify your request. The new table name will be in the format: 
xxxxx_yyyymmdd_hhmmss, where xxxxx is either the query type (Overlap, Quick or Adhoc) or the 
source table mnemonic in the case of a Standard Query (Network, Group, etc.) and yyyymmdd 
and hhmmss will be the date and time of the query, respectively. An example using the above 
illustration would be Quick_20080315_112804. 
 

Exporting as a spreadsheet 
 
To save the data into MS-Excel, from the File menu of query results display, select the Export 
query results as: A MS-Excel worksheet option, as shown in the illustration above. This will 
produce the results as a unique worksheet within a new or existing MS-Excel file. The name of the 
new worksheet will be of the format xxxxx_yyyymmdd_hhmmss, where xxxxx will be the type of 
query (quick, adhoc, etc.) and yyyymmdd and hhmmss will be the date and time of the query, 
respectively.  SpaceQry uses the ITU software package IWRocket to produce the MS-Excel file. 
This software can be installed from the SRS-on-DVDROM or downloaded from the SpaceQry 
website.  
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